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1-12-2022: Updated INROADSALL.EXE
Updated:  Style sheets:

 GDOT RW Table.xsl
 GDOT RailRoad RW Table.xsl

o The REQD_P_TESMT and REQD_P_DWESMT Feature Definitions now 
depict Bearing/Distance and SF/Acres as well as Station/Offset. The 
Right of Way Office requested these Easement changes to correspond 
to the Permanent Easement (REQD_P_PESMT). The reason for the 
request is complete legal descriptions are needed for condemnations.              
Also, per request from RW Office, the Table Header Information was 
changed to remove PERM and TEMP and replace with EASM'T FOR 
CONST AND MAINT OF ______ and EASM'T FOR CONST OF ______ 
respectively.  The DWESMT nor REQD table header were changed. Since 
the Descriptions are longer, the table headers have been modified to 
consist of three lines instead of all text on one line. InRoads provides a 
Description of the R/W, therefore Parcel ___ placeholder was not added 
to the header as it was in ORD for the R/W Alignment.-->

 XIN File – Updated as follows:
o Revised the filters below which are used during the Survey QA process of 

the DTM.
 Breaklines (should be Random).  TOPO_E_TFT will now report if it is 

stored as a breakline.

10-27-2021: Updated INROADSALL.EXE
Updated:  Standard Files:

 XIN File – Updated as follows:
o Revised the filters below which are used during the Survey QA process of 

the DTM.
 Breaklines (should be Random).  TOPO_E_TFT will now report if it is 

stored as a breakline.
 Random (should be Breakline).  TOPO_E_TFT was removed from the 

filter. The TFT should be stored as a random point not a breakiline.

 
08-03-2021: Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – Updated as follows:

o Edited the feature filters below to account for the feature 
TOPO_E_TCBLBAR.  These filters are used during the Survey QA process. 
 Non_Standard_Features
 Breaklines (should be Random)
 Triangulate=YES (should be NO)

INROADSALL HISTORY
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06-02-2021: Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – Updated as follows:

o Created a new feature filter named TRIANGULATED FEATURES in order to 
view only Triangulated Features.

o Edited the feature filter named DTM2CSV_Random-DIM to include 
TOPO_E_SDCD, SLCD, SLCM, SNGCM and SBNCHMK

03-06-2020: Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – Updated as follows:

o Corrected TOPO_E_TRP to point to plus sign instead of inverted triangle 
cell

o UTLE_E_UUMHTC now points to correct cell
o All Subsurface Utility feature styles that are breaklines, and also the 

column edge (TOPO_E_TCOLE), were edited to include the Survey 
options “Draw Connecting Line” and “Draw Line to Previous Same Code” 
to facilitate proper displaying of the features.

 ITL File – The following templates listed below were added and/or updated.
o Type 2S_MASH/LRFD Compliant – upcoming changes coming soon to 

Standard 4949B, reflected in this template.
o TP P1, P2 & P3 Parapet Retaining Wall_MASH/LRFD Compliant - 

upcoming changes coming soon to Special Detail/Standard 4949D, 
reflected in this template. Handrails removed.

o 9032B TP 1 CURB & GUTTER
o 9032B TP 1 DOWELED INTEGRAL CURB
o 9032B TP 1 HEADER CURB
o 9032B TP 6 HEADER CURB
o 9032B TP 9 CURB & GUTTER
o 9032B TP 9 DOWELED INTEGRAL CURB
o 9032B TP 9 HEADER CURB

01-01-2020: Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – All Existing Utility survey Feature Styles that have associated cells 

have been changed so that they use general, utility-type levels:
o All Existing Electric utility cells are on level UTLE_E_Elec-Cell
o All Existing Gas utility cells are on level UTLE_E_Gas-Cell
o All Existing Miscellaneous utility cells are on UTLE_E_Misc-Cell
o All Existing Petroleum utility cells are on level UTLE_E_Petro-Cell
o All Existing Sanitary Sewer cells are on level UTLE_E_San-Swr-Cell
o All Existing Telephone utility cells are on level UTLE_E_Tele-Cell
o All Existing Traffic Control utility cells are on level UTLE_E_Traf-Ctrl-Cell
o All Existing TV utility cells are on level UTLE_E_TV-Cell
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o All Existing Water utility cells are on level UTLE_E_Wat-Cell
 XIN File – The following new Feature Styles (and associated Named 

Symbologies) have been added for Existing Utility/SU features:
o UTLE_E_SUEB – U/G electrical line QL-B
o UTLE_E_SUED – U/G electrical line QL-D
o UTLE_E_SUFMB – U/G sanitary sewer force main line QL-B
o UTLE_E_SUFMD – U/G sanitary sewer force main line QL-D
o UTLE_E_SUGB – U/G gas line QL-B
o UTLE_E_SUGD – U/G gas line QL-D
o UTLE_E_SUNPWB – U/G non-potable water line QL-B
o UTLE_E_SUNPWD – U/G non-potable water line QL-D
o UTLE_E_SUPB – U/G petroleum line QL-B
o UTLE_E_SUPD – U/G petroleum line QL-D
o UTLE_E_SUSSB – U/G sanitary sewer line QL-B
o UTLE_E_SUSSD – U/G sanitary sewer line QL-D
o UTLE_E_SUSTMB – U/G steam line QL-B
o UTLE_E_SUSTMD – U/G steam line QL-D
o UTLE_E_SUTB – U/G telephone line QL-B
o UTLE_E_SUTD – U/G telephone line QL-D
o UTLE_E_SUTCB – U/G traffic control line QL-B
o UTLE_E_SUTCD – U/G traffic control line QL-D
o UTLE_E_SUTH – test holes for subsurface utilities
o UTLE_E_SUTVB – U/G TV line QL-B
o UTLE_E_SUTVD – U/G TV line QL-D
o UTLE_E_SUUB – U/G Unknown line QL-B
o UTLE_E_SUWB – U/G water line QL-B
o UTLE_E_SUWD – U/G water line QL-D
o UTLE_E_UUPGAE – electric (power/light) pole anchors
o UTLE_E_UUPGAT – telephone pole anchors
o UTLE_E_UUPGATC – traffic control/signal pole anchors
o UTLE_E_UUPGATV – TV pole anchors
o UTLE_E_UUTVPOL – TV pole
o UTLE_E_UUNGVM – U/G natural gas valve marker
o UTLE_E_UUPLM – U/G petroleum line marker
o UTLE_E_UUPVM – petroleum valve marker
o UTLE_E_UUSFMVM – U/G sanitary sewer force main line marker
o UTLE_E_UUSFMVM – sanitary sewer force main valve marker
o UTLE_E_UUTCHH – traffic control handhole
o UTLE_E_UUMHTC – traffic control manhole
o UTLE_E_UUTVCAB – TV Cabinet
o UTLE_E_UUWSLM – U/G water line marker

 XIN File – The new Feature Styles above were added into various filters used in 
InRoads.

 XIN File – The new Feature Style TOPO_E_TGC was added for GDOT staff to 
monitor ground shots, such as landslide sites.

GDOT Style Sheets



4 | P a g e

 The Style Sheet GDOT Alignment Report.xsl was revised to fix an error when 
printing.  It was erroneously listing incorrect Alignment Names on the headers 
when printed or saved as a PDF.  It will now print correctly or save out as a PDF 
with the correct Alignment Names listed.

 Four new Style Sheets have been added to assist in converting ALG and DTM 
files to CSV files for the purposes of importing the data into OpenRoads 
Designer.  See their respective InRoads Help Files for details on their use.

o GDOT ALG2CSV.xsl
o GDOT DTM2CSV-Breakline.xsl
o GDOT DTM2CSV-Random.xsl
o GDOT Feature Discontinuity Report.xsl

5-7-19: Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – The Feature Selection Filters “Breaklines (should be Random)” and 

“Random (should be Breaklines)” were revised to correctly report when a 
column edge feature using feature style TOPO_E_TCOLE is an error (it should be 
a Breakline feature type).

4-18-19: Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – Several Feature Selection Filters were updated to properly report 

some of the new Utility Feature Styles added in the 1-31-19 update.
 XIN File – The feature style TOPO_E_DEW was updated so that it triangulates.  

Some Feature Selection Filters were updated as a result of this as well.

3-19-19: Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – The Feature Selection Filter “OldFeatureStylesNotInUse” was updated 

to no longer report features using feature style TOPO_E_DEW with this filter 
since that feature style is actually allowed.

1-31-19: Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – The Cross Section Creation Preferences listed below were updated to 

extend the offset limits from 80’ to 85’ L/R (Narrow) and from 140’ to 150’ L/R 
(Wide).  A new Preference was also added (Wide 20h 20v) for extra-wide cross 
sections with offsets up to 300’ L/R.

o Narrow 10h 10v
o Narrow 10h 10v PRE Drawing #’s
o Wide 10h 10v
o Wide 10h 10v PRE Drawing #’s
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 XIN File – Feature Style TOPO_E_TCOLE was changed to be a Breakline feature 
type instead of Random.  Column edges must now be individual features so that 
columns are not erroneously connected to each other.

 XIN File – All Utility feature styles that are points now display the appropriate 
cells from the GDOT-UT-Utility cell library instead of either a cell in the GDOT-
LS-Symbols library or a symbol cell (i.e. “plus sign” or circle).  These now match 
the Utility and SUE Legends.  31 new Utility Feature Styles have been added as 
well, which likewise point to cells in the GDOT-UT-Utility cell library.  New 
Named Symbologies have been added for these and all InRoads filters that look 
for the Utility feature styles have been updated (Survey Style Filters and several 
Feature Selection Filters).  Traffic Signal Boxes/Traffic Control Cabinets 
(UTLE_E_UUTSB) and Electrical Boxes (UTLE_E_UUELBOX) are now Random 
Feature Types instead of Breaklines, and display as cells.  New Utility Feature 
Styles are listed below (for details, see InRoads Field Survey Feature Codes):
UTLE_E_UUEHH UTLE_E_UUEMRK UTLE_E_UUEM UTLE_E_UUTFM
UTLE_E_UUTTWR UTLE_E_UUGPR UTLE_E_UUGTS UTLE_E_UUMHG
UTLE_E_UUGVT UTLE_E_UUPV UTLE_E_UUSARV UTLE_E_UUSCO
UTLE_E_UUSFMV UTLE_E_UUSGT UTLE_E_UUTELCAB UTLE_E_UUTHH
UTLE_E_UUTMRK UTLE_E_UUTB UTLE_E_UUTSPB UTLE_E_UUTSLC
UTLE_E_UUTVHH UTLE_E_UUMHTV UTLE_E_UUTVMRK UTLE_E_UUTVP
UTLE_E_UUWARV UTLE_E_UUWBFP UTLE_E_UUMHW UTLE_E_UUWPIV
UTLE_E_UUWSP UTLE_E_UUWVT UTLE_E_UUWVMRK

 XIN File – The Preferences for viewing Stationing were updated such that all 
annotation (Cardinal Stations, PI’s & Station Equations) reads in the same 
direction as the Regular Stationing itself.

 XIN File – All of the Preferences in the Geometry>View Geometry>Curve Set 
Annotation (except “Default”) have been updated to include the Design Speed.

 XIN File – Added new Feature Styles and Named Symbologies:
o MAIN_P_CableBarrier: proposed cable barrier
o TOPO_E_TCBLBAR: existing cable barrier
o PROP_E_LTD-ACCESS: existing Limited Access
o PROP_E_RWE-LTD-ACCESS: existing R/W & existing Limited Access

 XIN File – Updated all appropriate Preferences under the View Horizontal 
Annotation command to include the new R/W feature styles above.

 XIN File – Changed feature style UTLE_E_UUSSL so that it is a Breakline feature 
type instead of Random.

 XIN File – Added alpha code RWRR (Existing Railroad R/W Marker) to Survey 
Style Filters “Property and Alignment Codes” and “DTM Surface Codes”.  Also 
added alpha code ACLPCPT to “DTM Surface Codes”.

 XIN File – Updated Feature Selection Filter “Old Feature Styles Not In Use” to 
report usage of UTLE_E_UUMHST as an error.  Manholes for storm sewers must 
use feature style TOPO_E_UMHST.  All other manholes are considered as being 
Utility features.

 ITL File – The barrier templates listed below were revised to comply with new 
MASH/LRFD standards/details.  Documentation for these templates have been 

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/InRoads%20Field%20Survey%20Feature%20Codes.pdf
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updated as well.  Older versions of these barrier templates should no longer be 
used.

o TP 7 CS Barrier_MASH/LRFD Compliant
o TP 7 WS Barrier_MASH/LRFD Compliant
o TP P1, P2 & P3 Parapet Retaining Wall_MASH/LRFD Compliant (this is 

now a single template)
o TP S1, S2 & S3 Median Barrier_MASH/LRFD Compliant
o Type 2S_MASH/LRFD Compliant
o Type 6S_MASH/LRFD Compliant
o Gravity Wall Type A Insertion Back Face
o Gravity Wall Type A Insertion Front Face
o Gravity Wall Type C Insertion Back Face
o Gravity Wall Type C Insertion Front Face

 ITL File – The TP T Guardrail – 31” w/plastic block template was revised (block 
offset changed to comply with standard).  This required an update to the 
insertion point for this guardrail on the GACUTFIL template as well.

 DFT File – Added 2 Plan Notes for annotating Cable Barrier (BEGIN and END).

12-01-17:         Updated INROADSALL.EXE

Updated:  Standard Files:
 XIN File – The feature style TOPO_E_DJB is acceptable again for picking up 

junction boxes.  Removed this feature style from the feature filters 
“OldFeatureStylesNotInUse” and “Breaklines (should be Random)”.  Added to 
feature filter “Triangulate=YES (should be NO)”.

 XIN File – The feature style TOPO_E_POOL was changed to triangulate.  Moved 
this feature style from the feature selection filter “Triangulate=YES (should be 
NO)” to “Triangulate=NO (should be YES)”.

 XIN File – Changed the named symbology for feature style TOPO_E_UMHST 
from UTLE_E_UUMHST to TOPO_E_UMHST so it shows up on correct levels.

 XIN File – Changed some settings in the File>Import>Surface Advanced dialog 
preference called GDOT Mapping, as follows:

o Added DHWT (top of headwall/wingwall)
o Removed TSTP and TRCRE since they do not triangulate

11-09-17:         Updated INROADSALL.EXE 

GDOT Style Sheets
 Added Style Sheet – GDOT COGO Point Validation.xsl.  This style sheet will tell 

the user if any alignments are missing any COGO points (converted from the 
alignment points).

GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT COGO Point Validation.pdf

Updated:  Standard Files:
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 XIN File – The feature style TOPO_E_TBBB was changed to be a Breakline 
instead of Random Feature Type.  Removed from feature filter Random (should 
be Breakline).  Added to feature filters Breaklines (should be Random) and 
Triangulate=YES (should be NO).

 XIN File – The feature filter UtilityFeatureStylesUsingTOPO was updated to 
remove the feature style TOPO_E_UMHST.

 XIN File – The UTLE.DGN Feature Selection Filter used to create the UTLE.DGN 
file was updated to remove the manhole cover tops and flowlines for storm 
sewers (UTLE_E_UUMHST, UTLE_E_UUMHSTF, TOPO_E_UMHST and 
TOPO_E_UMHSTF feature styles).

 XIN File – The TOPO.DGN Feature Selection Filter used to create the TOPO.DGN 
file was updated to include the manhole cover tops for storm sewers 
(UTLE_E_UUMHST and TOPO_E_UMHST feature styles).

 XIN File – The Plan Text level for feature style TOPO_E_TBLDRL was changed 
from TOPO_E_TBLDRL-Line to TOPO_E_TBLDRL-Text.

08-10-17:         Updated INROADSALL.EXE 

Updated:  Standard Files:
 XIN File – The feature style PROP_E_PAR was corrected so that the proper 

levels were assigned.
 XIN File – Added new filter, Non_Standard_Features, which searches for any 

features that do not use standard GDOT feature styles.

07-31-17:         Updated INROADSALL.EXE 

Updated:  Standard Files:
 XIN File – The feature style TOPO_E_TSTP was changed so that it is excluded 

from Triangulation.
 XIN File – Added new feature style for bottom of bridge beam elevations: 

TOPO_E_TBBB.  Also added this feature style to the Feature Selection Filter: 
Random (should be Breaklines).

 XIN File – Added new feature style for existing easement lines: PROP_E_ESMT.  
This should be used for all existing easement alignments/chains instead of 
PROP_E_POEL.  Continue using PROP_E_POEL for any points on easements.

 XIN File – Added new filter, Survey_Control_Deltas, to aid in searching DTM to 
ensure Survey Control Delta points were included.

 XIN File – Added PROP_E_ESMT to the 2 filter Preferences: Prop.dgn 
Alignments and Stakeout Survey Data.

 XIN File – Added TOPO_E_TBRDGCEN to the Feature Selection Filter: 
OldFeatureStylesNotInUse, since this feature style has been discontinued and is 
only available for backwards compatibility.

04-30-17:         Updated INROADSALL.EXE 
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Updated:  Standard Files:
 XIN File – The feature styles TOPO_E_DHWE & TOPO_E_DCWE are retained for 

backwards compatibility, but replaced going forward with the 2 new feature 
styles TOPO_E_DHWT (Headwall/Wingwall Top) & TOPO_E_DHWB 
(Headwall/Wingwall Bottom).

 XIN File –Updated description of feature style TOPO_E_DCB to be “THROAT OF 
CATCH BASIN”, which is to be used on any catch basins, whether single or 
double.  Changed cell of this feature style to an “X”, so that it no longer displays 
a cell of a catch basin.

 XIN File – Added a new filter, “Crossing Segment Finder”, to find Survey 
Crossing Segments that do not include properly named exterior boundaries.

 XIN File – Added a new filter, “UtilityFeatureStylesUsingTOPO” to find any older 
Utility Feature Styles still using the discontinued TOPO_E_*** nomenclature.

 XIN File – Added TOPO_E_TSW to the TOPO.DGN filter.  Removed 
TOPO_E_TSW, TOPO_E_TDR & TOPO_E_TDD from the Topo Annotation filter.

 XIN File – Updated to correct all object heights to 3.5’ for both ISD-Cars and 
ISD-Trucks GDOT Preferences for the Sight Visibility>Surface Visibility tools.

 XIN File – Added a new filter, “OldFeatureStylesNotInUse”, to find features that 
use feature styles no longer accepted by GDOT.

 XIN File – Renamed the filters “Breaklines=Random” and “Random=Breaklines” 
to “Random (should be Breaklines)” and “Breaklines (should be Random)”, to 
make more sense.

12-20-16:         Updated INROADSALL.EXE 

GDOT Style Sheets
 Added Style Sheet – GDOT RailRoad RW Table.xsl

GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT RailRoad RW Table.pdf

10-15-16:         Updated INROADSALL.EXE 

Updated:  Standard Files:
 XIN File – The feature style TOPO_E_TSW was changed to depict sidewalk 

edges, instead of centerlines.  As a result, it now Triangulates by default.
 XIN File – The feature style TOPO_E_POOL was changed to not Triangulate by 

default and is no longer an Interior Feature Type.
 XIN File – Two new Feature Selection Filters have been added to find 

features in the DTM that are either triangulating when they should not 
be (based upon the feature style used), or are not triangulating when 
they should be.  These new filters are:  Triangulate=NO (should be YES) 
and Triangulate=YES (should be NO).

 XIN File – The feature styles TOPO_E_SBNCHMK, TOPO_E_SLCD, TOPO_E_SLCM 
and TOPO_E_SNGSCM below were updated to expand the annotation in the 
TOPO.DGN files.  The Survey Feature: Custom Operations section was expanded 
to include annotation of the Northing, Easting and Elevation of these points.  
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This additional annotation will now show up in the TOPO.DGN files and also in 
Section 11 and/or Section 13 of plans (if TOPO.DGN is referenced).  

 XIN File – A new Geometry Selection Filter Preference, called Survey 
Control Delta Annotation, has been added to aid in using the new Style 
Sheet (GDOT Survey Control Delta Annotation Report).  This Filter 
Preference will limit the COGO Points to only those feature styles needed 
for Plans Reproduction: TOPO_E_SNGSCM, TOPO_E_SLCM, 
TOPO_E_SLCD, and TOPO_E_SBNCHMK.

 XIN File – The feature style PROP_E_BGMD was added to the Survey Style Filter:  
Property and Alignment Codes.  The Numeric Code was changed from 0 to 135.

GDOT Style Sheets
 Added Style Sheet – GDOT Survey Control Delta Annotation Report.xsl

GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT Survey Control Delta Annotation Report.pdf

4-29-16: Updated INROADSALL.EXE 

Updated:  Standard Files:
 XIN File – Added numerous Drafting Notes which are summarized and detailed 

in the InRoads Workflow Processes document (see Workflow Process 9: Using 
Drafting Notes to Annotate Plans/Profiles).

 XIN File –  Added the following Named Symbologies for using Drafting Notes, so 
that leader lines and text of the Drafting Notes are all on the same level:

o ENVE_P_ORNG-FBarrier-Draft_Note
o MAIN_P_Appr-Slab-Drafting_Note
o MAIN_P_Barrier-Wall-Draft-Note
o MAIN_P_Beg-End-Const-Draft_Note
o MAIN_P_Bridge-Drafting_Note
o MAIN_P_Guardrail-Drafting_Note
o MAIN_P_Int_Labels-Drafting_Note
o MAIN_P_SIDE_RD-Label-Draft_Note
o REQD_P_DWESMT-Drafting_Note
o REQD_P_DWESMT-Pnt#-Draft_Note
o REQD_P_PESMT-Drafting_Note
o REQD_P_PESMT-Pnt#-Drafting_Note
o REQD_P_REQD-RW-Drafting_Note
o REQD_P_REQD-RW-Pnt#-Draft_Note
o REQD_P_RWRM-Drafting_Note
o REQD_P_TESMT-Drafting_Note
o REQD_P_TESMT-Pnt#-Drafting_Note

 XIN File – Under Project Options, changed the Abbreviations as follows.  
Removed the minus sign for the Left Offset Prefix.  Added a Left Offset Suffix of 
‘ LT and a Right Offset Suffix of ‘ RT.  This change helps to automate the usage 
of Drafting Notes to annotate Station-Offsets. 
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1-15-16: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File – Various updates/revisions. (See update/revision list in the Table 

depicted below).
 Survey_Data_Processing_InRoads_QA PDF – Updated the Survey Data 

Processing InRoads QA form to include additional items/tasks for the Survey QA 
Check process.  

GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT COGO Point Stakeout Report.pdf

GDOT Style Sheets
 Added Style Sheet – GDOT COGO Point Stakeout Report. Xsl

 New preferences were created for generating cross section and profile sheets that 
utilize the Pre drawing number sheet cells.  The names of these new preferences are:
 Narrow 10h 10v PRE Drawing #’s
 Wide 10h 10v PRE Drawing #’s
 20 Scale Double_PRE Drawing #’s
 20 Scale Single_PRE Drawing #’s
 50 Scale Single_PRE Drawing #’s
 50 Scale Double_PRE Drawing #’s

10-15-15: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File –Various updates/revisions. (See update/revision list in the Table 

depicted below).

 The command Evaluation>Sight Visibility>Surface Visibility was revised to remove the 
preference ‘Surface Visibility’ and replace it with 3 new preferences.  The preference 
‘ISD – Car’ with an object height of 3.5’ and an eye height of 3.5’, the preference ‘ISD – 
Truck’ with an object height of 3.5’ and an eye height of 7.6’ and the preference ‘SSD’ 
with an object height of 2.0’ and an eye height of 3.5’.

7-31-15: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File –Various updates/revisions. (See update/revision list in the Table 

depicted below).
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GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT Point Description Counter.pdf
 Added Style Sheet Help File – GDOT Point Summary With Stations.pdf
 Revised Style Sheet Help File – GDOT Earthwork Volumes Report.pdf
 Revised Style Sheet Help File – GDOT End-Area Report-Standard.pdf
 Revised Style Sheet Help File – GDOT End-Area Report-Compressed.pdf
 Revised Style Sheet Help File – GDOT Feature Volumes Report.pdf
 Revised Style Sheet Help File – GDOT GPS Grading Report.pdf

GDOT Style Sheets
 Added Style Sheet – GDOT Point Description Counter. xsl
 Added Style Sheet – GDOT Point Summary With Stations. xsl
 Revised Style Sheet – GDOT End-Area Report-Standard. xsl
 Revised Style Sheet – GDOT End-Area Report-Compressed. xsl
 Revised Style Sheet – GDOT GPS Grading Report. xsl

 The filter TOPO.dgn was edited to include the Feature Style TOPO_E_TBCAP
 The Feature Style SIGN_P_MISC was added at the request of design.  It is on a non-

plotting level and is intended to be used to help quantify proposed signs.
 The Feature Style SIGN_P_MISC will automatically display the point number and point 

description.

4-30-15: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File –Various updates/revisions. (See update/revision list in the Table 

depicted below).

 ITL File – The ITL file was updated to reflect revisions to the GACUTFIL 
component to change the slope constraint to a vector offset constraint for the 
following points. The change was made to simplify sloping of the shoulder. 

o GRL_T_PlasticBlock_or_W27”
o GRL_W31”
o GRL_T_MetalBlock

GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT Parcel Check Report.pdf

GDOT Style Sheets
 Added Style Sheet – GDOT Parcel Check Report. xsl

 Edited the filter ‘UTLE Annotation’ to correct the include all setting to exclude all so that 
all feature styles would be excluded from annotation except Alpha code TMPR and SMI 
code 235. This filter is used with the command ‘Survey>View Survey Data>Write Survey 
Data to Graphics’.
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 Added a new filter preference named ‘PROP_E_PAR’. This filter preference is used with 
the command ‘Tools>XML Reports>Geometry’ when creating the style sheet ‘GDOT 
Parcel Check Report’ for survey QA checks.

 The preferences under the command Geometry>View Geometry>Curve Set Annotation 
were revised to display the northing and easting coordinates to four decimal places.  
The preferences affected are ACL, CONSTCL, DETCL and SIDECL.

 The filters ‘Breakline=Random’ and ‘Random=Breakline’ were edited to ensure the 
feature styles TOPO_E_DJB, TOPO_E_DMISC and TOPO_E_TMISC were not be reported 
when either filter was being used to generate a report.  This is because these feature 
styles are not standard GDOT feature styles and should not be used by anyone.  They 
are in the XIN file only because of backwards compatibility and because they were in the 
list of CAICE feature codes.

 The advanced surface importer for Mapping was edited to include TECP to the list of 
items imported into InRoads.

10-31-14: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File –Various updates/revisions. (See update/revision list in the Table 

depicted below).

GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT HEC RAS (Wide Floodplain) Cross Section 

Geometry Report.pdf
 Added Style Sheet Help File –  GDOT Roadway Design Milling Report.pdf
 Added Style Sheet Help File  –  GDOT SUE Utility QL-A Location Report.pdf

GDOT Style Sheets
 Added Style Sheet – GDOT HEC RAS (Wide Floodplain) Cross Section Geometry 

Report. xsl
 Added Style Sheet – GDOT Roadway Design Milling Report. xsl
 Added Style Sheet – GDOT SUE Utility QL-A Location Report.xsl

 The ‘random = breakline’ filter was edited to exclude the additional breaklines DBOD 
and DTOD.

 Added the TEAD Feature Code to the Advanced Surface Importer for Photogrammetry.
 Edited the preferences SE LEFT and SE RIGHT due to a bug in InRoads.  SE LEFT was 

displaying on the Right side of the roadway and SE RIGHT was displaying on the Left side 
of the roadway.

 Created the following  new Named Symbologies and/or Feature Styles
 Edited the UTLE.DGN filter to add the following Feature Styles

UTLE_E_UUSTRPOL UTLE_E_UUPGA UTLE_E_UUMHE
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UTLE_E_UUELBOX UTLE_E_UUYLE UTLE_E_UUMHSS
UTLE_E_UUOEL UTLE_E_UUYLG UTLE_E_UUMHSSF
UTLE_E_UUOTL UTLE_E_UUWM UTLE_E_UUSSL
UTLE_E_UUPP UTLE_E_UUWV UTLE_E_UUGM
UTLE_E_UULP UTLE_E_UUFH UTLE_E_UUNGV
UTLE_E_UUTP UTLE_E_UUMHST UTLE_E_UUNGVP
UTLE_E_UUTPD UTLE_E_UUMHSTF UTLE_E_UUNGLM
UTLE_E_UUGP UTLE_E_UUMHT UTLE_E_UTRCR

UTLE_E_UTRCL
UTLE_E_UTSATDSH
UTLE_E_UTMPR
UTLE_E_UXX

 Created the following new Named Symbologies and/or Feature Styles:

o UTLE_E_UUTSB
o UTLE_E_UUPCL
o UTLE_E_UUFM
o UTLE_E_SUETOP
o UTLE_E_SUEBOT

 Created a preference named SUE for the annotation of Subsurface Utility features on 
profiles.

 Created a new Survey Style filter named UTLE Annotation that includes the following 
feature styles

o TOPO_E_TMPR (Numeric code 235)
o UTLE_E_UTMPR (Alpha code UTMPR)

 Edited the TOPO Annotation Survey Style filter to remove the following feature styles
TOPO_E_TMPR

 Edited the TOPO.DGN filter to remove the following feature styles
o TOPO_E_TRCL
o TOPO_E_TRCR
o TOPO_E_TSATDSH

 Edited the Random=Breaklines preferences to exclude the following additional features
o UTLE_E_SUEBOT
o UTLE_E_SUETOP
o UTLE_E_UTRCL
o UTLE_E_UTRCR
o UTLE_E_UUELBOX
o UTLE_E_UUOEL
o UTLE_E_UUOTL
o UTLE_E_UUTSB
o UTLE_E_UXXB
 Edited the Breaklines = Random preference to exclude the following additional features
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UTLE_E_SUEBOT UTLE_E_UUMHE UTLE_E_UUSTRPOL
UTLE_E_SUETOP UTLE_E_UUMHSS UTLE_E_UUTP
UTLE_E_UTMPR UTLE_E_UUMHSSF UTLE_E_UUTPD
UTLE_E_UTSATDSH UTLE_E_UUMHST UTLE_E_UUWM
UTLE_E_UUFH UTLE_E_UUMHSTF UTLE_E_UUWV
UTLE_E_UUGM UTLE_E_UUMHT UTLE_E_UUYLE
UTLE_E_UUGP UTLE_E_UUNGLM UTLE_E_UUYLG
UTLE_E_UUPGA UTLE_E_UUNGV UTLE_E_UXXA
UTLE_E_UUPP UTLE_E_UUNGVP UTLE_E_UUPCL
UTLE_E_UULP UTLE_E_UUSSL UTLE_E_UUFM

 Created a new preference named XSEC TEXT-SUE for the annotation of Subsurface 
Utility features on the cross sections.

 Edited the feature styles UTLE_E_SUETOP and UTLE_E_SUEBOT to check the ‘Draw line 
to previous same code’ 

07-31-14: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File –Various updates/revisions. (See update/revision list in the Table 

depicted below).

GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT Feature Report.pdf

GDOT Style Sheets
 Added Style Sheet – GDOT Feature Report. xsl

 Added a Filter named ‘Breaklines = Random’ which filters features which are normally 
brought in with a feature type of breakline that have been brought into the DTM as a 
feature type of random.  This is useful in identifying features that were collected in the 
field in which the ST control code may have been inadvertently left out.

 Added a Filter named ‘Random=Breakline’ which filters features which are normally 
brought in with a feature type of Random that have been brought into the DTM as a 
feature type of Breakline.  This is useful in identifying features that were collected in the 
field in which the ST control code may have been inadvertently added.

 The Survey Style Filter for ‘TOPO ANNOTATION’ was edited to include annotation for the 
feature styles TBLD, TBLDRL, THCR, THRL, TMHCR, and TMHRL.  The survey field Crews 
will now be collecting attributes for these feature styles at the request of the Design 
office for labeling of Building Descriptions on the R/W plans.

 All TOPO feature styles (except TRP) with a feature type of ‘Random’ were changed to 
create a separate feature for each item rather than including all items in a single 
feature.  This is to simplify field collection and ensure each feature has its own 
description field.

 The feature style TOPO_E_SBNCHMK was edited to include a custom operation so that it 
could be annotated in the TOPO.dgn file.  The filter ‘Topo Annotation’ was edited to 
include this feature style and the filter ‘TOPO.dgn’ was edited to remove this feature 
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style so duplicates would not be in the final TOPO.dgn deliverable. This change was 
requested by survey.

 Custom operations were added for the feature styles TBLD, TBLDRL, THCR, THRL, 
TMHCR, and TMHRL.  The custom operations allow topo annotation to be displayed on 
the TOPO.dgn file.  This was requested by location so building labels will annotate on 
the R/W plans.

4-07-14: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File – Various updates/revisions. (See update/revision list in the Table 

depicted below).
 ITL File – The ITL file was updated to reflect revisions to the following 

components to either add a safety edge according to Construction Detail P-7 or 
vertical face paving according to Construction Detail S-4b: 
o Inside Shoulder
o Outside Shoulder – Full Depth
o Outside Shoulder – Partial Depth
o Paving Under Guardrail
o Concrete Lane - Outside

Component Description Documentation
 The following Component Description Documents were revised to reflect the 

above changes:
o Inside Shoulder
o Outside Shoulder – Full Depth
o Outside Shoulder – Partial Depth
o Paving Under Guardrail
o Concrete Lane - Outside

 A Preference named Driveway Profiles was created for the commands ‘Create Profile’ 
and ‘Annotate Profile’ for use in creating Driveway Profile sheets when horizontal and 
vertical alignments for driveways have been created.

 Set up the symbology for Plan Point and Plan Line for the Named Symbology 
MAIN_P_Details-Begin-End-Const-

 3 new named symbologies were created for the Sight Visibility Tools.
o MAIN_P_SightDistance-Green
o MAIN_P_SightDistance-Yellow
o MAIN_P_SightDistance-Red
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 2 new preferences were created for the Sight Visibility Tools.
o Roadway Visibility
o Surface Visibility

 The Feature Style PROP_E_PCF was edited so that attributes could be collected in the 
field and they will display in InRoads.

 Added the Survey Style Filter ‘Prop Annotation’ for the display of attributes on the 
Feature Style PCF.

 The ‘GDOT’ Preference located under the command ‘Survey-Survey Data to Surface’ was 
edited to change the curve stroking mode from ‘Horizontal and Vertical’ to ‘Horizontal 
Only’

 Under the command ‘Survey-Survey Data to Geometry’, a preference named ‘GDOT’ 
was added that sets the curve stroking mode to ‘Horizontal Only’ and Description to 
‘Use Attributes’.

1-13-14: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File – Various updates/revisions. (See update/revision list in the Table 

depicted below).
 ITL File – The ITL file was updated to reflect revisions to the following: 

- the Type 2S, Type 6S and the four Parapet Retaining Wall templates 
have been updated with unique Feature Styles to facilitate creation of 
Wall Envelopes/Profiles.

- The Type 2S with 2:1 Fill and Type 2S with 4:1 Fill templates have been 
consolidated into one template named Type 2S.

- Seven new templates for Gravity Type Wall have been added which 
include unique Feature Styles to facilitate creation of Wall 
Envelopes/Profiles.

Component Description Documentation
 The following Component Description Documents were added/revised:

o Gravity Wall
o TP 2S Barrier
o TP 6s Barrier
o TP P1, P2 & P3 Parapet Retaining Wall 

 Added the following new feature styles at the request of Location.
o TOPO_E_DBOD
o TOPO_E_DTOD

 Edited the TOPO.DGN filter to include the new feature styles above.
  Edited the feature styles MAIN_P_CONSTCL and MAIN_P_SIDECL so the bearing would 

be to 0.1” when displayed.
 A preference named USACoE_404_Permit was added to the 3 commands listed below 

for use in creating a Stream Profile and Stream Cross Sections.  
o Geometry > View Geometry > Stationing
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o Evaluation > Profile > Create Profile
o Evaluation > Cross Section > Cross Sections

 The point symbology of the feature style TOPO_E_SBF for Plan, Profile and Cross Section 
views was changed from a cross to a square to differentiate from feature style 
TOPO_E_SXS.

 The feature style TOPO_E_SBF was changed from an un-triangulated random feature 
type to an un-triangulated breakline feature type so that it can be displayed as a 
continuous line in profile views. 

 Added a new Preference called WallProfiles under Evaluation>Profile>Annotate Feature 
in Profile.  This new Preference is used to annotate the elevations of major stations for a 
Wall Envelope every 50’ along the axis.

 Added new Feature Style MAIN_P_WALL-PROF-Exist-Grd-TP6 specifically for Type 6 
Concrete Side Barriers, used mainly for developing Wall Envelopes.

 Modified the Profile Text Symbology for the Feature Style MAIN_P_Barrier-Retain-Wall 
to rotate 0⁰ in order to facilitate annotating Wall Envelopes/Profiles.

 Modified the Profile Text Symbology for the following Feature Styles to rotate 90⁰ and 
also changed some of the Offsets, in order to facilitate annotating Wall 
Envelopes/Profiles:

o MAIN_P_WALL-PROF-Top-of-Wall (Wall Profile – Top of Wall)
o MAIN_P_WALL-PROF-Bottom-of-Wall (Wall Profile – Bottom of Wall)
o MAIN_P_WALL-PROF-Top-of-Footing (Wall Profile – Top of Footing)
o MAIN_P_WALL-PROF-Finish-Grd-BoW (Wall Profile – Finished Ground line at 

Back Face of Wall)
o MAIN_P_WALL-PROF-Finish-Grd-FoW (Wall Profile – Finished Ground line at 

Front Face of Wall)
o MAIN_P_WALL-PROF-Existing-Grd (Wall Profile – Existing Ground line or Backfill 

Slope Tie-in)

10-21-13: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File – Various updates/revisions. (See update/revision list in the Table 

depicted below).

 Corrected the Feature Style TOPO_E_TFE so that the Points are depicted when viewing 
Surface Features.

  The Survey options 20 Scale and 50 Scale preferences were edited so when the 
Survey>View Survey Data> Symbols, Names, Codes, Elevations, Errors and Notes options 
are checked, the point names will be visible.  The current sizes of .15 and .375 are 
displaying too small to be visible.  They were changed to 10 and 10.

 The named symbologies MAIN_P_SIDECL, MAIN_P_SIDECL-Brng, MAIN_P_SIDECL-
Curve-Data, MAIN_P_SIDECL-Tic-Sta and the preferences SIDECL and SIDECL 20 Scale, 
located in the commands Geometry>View Geometry>Station and Curve Set Annotation, 
were edited to display elements on the new levels MAIN_P_SIDECL-TIC-Sta-Cell, 
MAIN_P_SIDECL-Tic-Sta-Line, MAIN_P_SIDECL-PC-PT-Sta-Ldr-Cell, MAIN_P_SIDECL-PC-
PT-Sta-Ldr-Line, and MAIN_P_SIDECL-Curve-Data-Cell.
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 The Plan and Profile Generator preferences named 20 Scale Double Profile and 50 Scale 
Double Profile were edited to make a correction in the way double profiles are 
displayed.  Double profiles will now be displayed with the lowest stationing on top and 
the highest stationing at the bottom.  This was done in order to maintain consistency 
with the way double profiles have traditionally been displayed in the past at GDOT.

 Changed the Point Named Symbology Symbols of the following Feature Styles from 
Triangles to Plus Signs: MAIN_P_Barrier-Median-Side, MAIN_P_Barrier-Retain-Wall and 
MAIN_P_Barrier-Sound-Wall.  

09-03-13: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File – The XIN File was updated to include new Feature Styles. The Feature 

Styles TOPO_E_SBF (Stream Bank Full) and TOPO_E_SXS (Stream X- Section) 
were added in order to collect these items for the USACE 404 Permit. Both 
Feature Styles are non-triangulated 3D points that go to the DTM and indicate 
where Stream Cross Sections need to be created and where the Stream Bank- 
Full has been located by the Ecologist.

07-15-13: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File – The XIN File was revised to include new codes for the 

Photogrammetry Softcopy software.  The ‘Import Surface Advanced’ command 
was also set up for the new Photogrammetry Softcopy Mapping processes. (See 
update/revision list in the Table depicted below for detailed information).

GDOT Style Sheet Documentation
 Revised Style Sheet Help File – GDOT Surface Check Report.pdf to correct a typo 

error depicting ‘Imperial’ units instead of ‘US Survey Foot’ units.
GDOT Style Sheets
 The GDOT RW Table.xsl Style Sheet was edited to correct an error with the 

decimal places on the last point listed in the table.  The last point was only 
reporting to one decimal place while all other points were reporting to two 
decimal places.  The last point was corrected to report to two decimal places.

 The GDOT Surface Check Report.xsl was edited to correct the units depicted in 
the report from “Imperial” to “US Survey Foot”.  Only the text in the header was 
incorrect. 

 Edited the Named Symbology for the following feature styles to look at the new plan view 
cells that were created for mapping.
 TOPO_E_UFH TOPO_UFH
 TOPO_E_TSATDSH TOPO_TSAT
 TOPO_E_UYLE TOPO_UYLE
 TOPO_E_UYLG TOPO_UTLG
 TOPO_E_UMHSSF TOPO_UMHSSF
 TOPO_E_UMHSTF TOPO_UMHSTF
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 Edited the preference ‘Prop.dgn Points’ to include the feature styles PROP_E_ACL and 
PROP_E_ACL-PC-PT.  This preference is used with the ‘View Horizontal Annotation’ 
command when creating the PROP.dgn file for delivery to the designer.

 Set up the ‘Import Surface Advanced’ command with the Rule Set Name ‘GDOT Mapping’.  
This is for use by the photogrammetry department to import 3d MicroStation files created 
by the new summit mapping software.
 Edited the feature style TOPO_E_TRP so that the plus symbol was displayed rather than 

the TIC1 cell.  This was done to increase viewing speed of TRP points.  The plus symbol 
looks very similar to the TIC1 cell.

 Edited the named symbology for the feature style TOPO_E_TCOR so that the new 
profile and cross section levels for this item would be used.

 Added Feature Styles and Named Symbology for the following:
 MAIN_P_WALL-PROF-Top-of-Wall (Wall Profile – Top of Wall)
 MAIN_P_WALL-PROF-Bottom-of-Wall (Wall Profile – Bottom of Wall)
 MAIN_P_WALL-PROF-Top-of-Footing (Wall Profile – Top of Footing)
 MAIN_P_WALL-PROF-Finish-Grd-BoW (Wall Profile – Finished Ground line at Back Face 

of Wall)
 MAIN_P_WALL-PROF-Finish-Grd-FoW (Wall Profile – Finished Ground line at Front Face 

of Wall)
 MAIN_P_WALL-PROF-Existing-Grd (Wall Profile – Existing Ground line or Backfill Slope 

Tie-in)
 Edited the named symbology for the feature style TOPO_E_TCOR so that the new profile 

and cross section levels for this item would be used.
 Added Feature Styles and Named Symbology for the following:

o TSTP – White line Stripping (Breakline to be included in triangulation)
o TRIVER – River (Interior boundary)
o FNDN – Foundation (Interior boundary)
o RUIN – Ruins (Breakline to be included in triangulation)
o POOL – Swimming Pool (Interior boundary)
o TLAKE – Lake (Interior boundary)
o TEL – Emergency Lane (Breakline to be included in triangulation)
o TCOR – Crown of Road (Breakline to be included in triangulation)

The symbol for the TRP points were changed from a circle to a cell named Tic1 which 
looks like a plus symbol.

 04-08-13: Updated INROADSALL.EXE 

 Updated:  Standard Files:
 XIN File – The display scale of the cells was changed from .014 to .14 for the 

Feature Styles TOPO_E_TSC and TOPO_E_TKMP.
 ITL File – The ITL file was updated to reflect a revision to the TP P1, P2 & P3 

Parapet Retaining Wall templates to correct a conflict with varying slopes of the 
active surface.

Component Description Documentation



20 | P a g e

 The following Component Description Documents were revised:
o TP P1, P2 & P3 Parapet Retaining Wall with 2to1 Back Slope
o TP P1, P2 & P3 Parapet Retaining Wall with 3to1 Back Slope
o TP P1, P2 & P3 Parapet Retaining Wall with 4to1 Back Slope
o TP P1, P2 & P3 Parapet Retaining Wall with 6to1 Back Slope

02-01-13: Released INROADSALL.EXE – Initial Select Series 2 Version
InRoads ALL.exe was renamed from InRoads ALLV8i.exe to InRoadsALL.exe. This version 
of InRoadsALL.exe works on InRoads Select Series 2/InRoads V8i versions as well as 
Windows 7 (32/64 bit) and Windows XP Operating Systems.

Updated:  Standard Files:
 XIN File – The XIN file (and associated Preferences) was updated to work in 

InRoads Select Series 2 and InRoads V8i. The XIN file was also updated to work 
in both Windows 7/Windows XP. The XIN file was renamed to GDOT_Standard 
V8i_SS2.xin (See update/revision list in the Table depicted below).

 ITL File – The ITL file was updated to work in InRoads Select Series 2 and 
InRoads V8i. The ITL file was also updated to work in both Windows 7/Windows 
XP. 

 MDB File – Added GDOT (PI#) Pay Item Database. mdb for use in Quantity 
Manager.

GDOT Style Sheet Documentation
 Revised Style Sheet Help File – GDOT GPS Grading Report.pdf to reflect the 

generation and distribution to Contractors of the GDOT GPS Grading Report 
“pre-award” instead of “post-award”.

GDOT Style Sheets
 The GDOT RW Table.xsl Style Sheet was revised to correct an error when writing 

Deeds with Curve information at the end of the alignment.

 Created two new feature styles.  MAIN_P_OVERLAY and MAIN_P_MILLING for use with 
the new overlay and milling component in SS2.

  Edited all the TOPO features styles so they could be displayed/annotated on profiles.
 Edited the preferences under the command Geometry > View Geometry > Curve Set 

Annotation to place a check in the Left Hand Cell and Right Hand Cell check box.  This is 
a new check box in SS2.  The curve data location is controlled by the offsets in the text 
settings of the same dialog but if these check boxes are ignored, the offset settings are 
ignored.

 Edited the Design Default preference loaded in the project options dialog so that the 
Sight Distance – Eye Height, Stopping Object Height and Passing Object Height would be 
set to 3.5, 2.0 and 3.5 respectively.

 Edited all the feature styles that had the check box ‘Point Name’ unchecked under the 
geometry feature/points folder to ensure they were checked.  This allows users to use 
the feature style when storing points and have the point name display when displaying 
the point. 

 Edited the preferences 20 Scale and 50 Scale located under Tools > Survey options so 
that the Point and Figure Seeds would begin at 1.
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 Named symbologies and preferences were edited to use new levels in MicroStation 
created specifically for Plan, Profile or Cross Section Views.

 Edited all the MAIN_P_**** styles to uncheck the Surface Feature > 3-D/Plan Display > 
Points box.  This is so a Pay Item wouldn’t be assigned to each point when the Assign 
Pay Items command is used in Quantity Manager

10-01-12: Updated INROADSALLV8i.EXE

Updated:  Standard Files:
 ITL File – Various updates/revisions. (See update/revision list in the Table 

depicted below).
Component Description Documentation

A Component Description Document for the ‘TP P1, P2 & P3 Parapet Retaining 
Wall’ Component was added.

GDOT Style Sheets
 The Style Sheet install locations were changed from the C:\Program 

Files\Bentley\InRoads Group V8.11\XML Data folder to the C:\InRoads 
Data\Style Sheets folder.  This is so that a single InRoadsALL.exe will work on 
both Windows XP and Windows 7 -- 32 and 64 bit machines.   

 A new component named ‘TP P1, P2 & P3 Parapet Retaining Wall’ was created.
 Revised the template ‘TP W Guardrail’ to be 31” tall rather than 27” inches tall in 

response to changes to the standards.
 Revised the template ‘Type 2S’ so that the default depth of the footing is always 10” 

below the existing ground as measured from the existing ground to the top right corner 
of the footing as shown on the standards.

07-15-12: Updated INROADSALLV8i.EXE

Updated:  Standard Files:
 XIN File – Various updates/revisions. (See update/revision list in the Table 

depicted below).
GDOT Style Sheet Documentation
 Revised Style Sheet Help File – GDOT RW Table.pdf to correct a screen capture.

GDOT Style Sheets
 Revised Style Sheet – GDOT RW Table.xsl to report the SF to two decimal places.
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 Revised Style Sheet – GDOT Earthwork Volumes Report.xsl to correct a 
 reporting issue when empty cross section stations are represented.

 All TOPO_E_#### Feature Styles were edited to include an attribute name.  Attributes 
collected in the field will now display in the description field for the Surface ►Feature 
Properties dialog.

 The Named Symbology TOPO_E_TETL and the Feature Style TOPO_E_TETL were 
created.

 The Filter DTM Surface Codes was revised to include the Feature Style TOPO_E_TETL.  
This filter is used by Survey with the command Surface ►Survey Data to Surface when 
data is copied from the Survey module to the Surface module.

 The Filter EXIST_RDWY-ACL+EOP+RR was revised to include the Feature Style 
TOPO_E_TETL.  This filter is used with the command Surface ►View Surface ►Features 
for viewing only existing roadway and railroad features for developing centerlines.

 The Filter TOPO.DGN was revised to include the Feature Style TOPO_E_TETL.  This filter 
is used by Survey with the command Surface ►View Surface ►Features when creating 
the TOPO.DGN file for delivery to design.

 All TOPO_E_**** Feature Styles with a ‘Breakline’ or ‘Interior’ feature type were revised 
to turn off the display of the points.  Exceptions to this are TOPO_E_DCEF, DPC, DPM, 
DPP and TLIML. The reason for this is to increase the viewing speed of the existing DTM 
features.

 All TOPO_E_**** Feature Styles were edited to have the ‘Annotate’ check box checked 
in the style manager under the ‘Surface Feature’ leaf. This enables the feature to be 
annotated in the cross sections when using the command Evaluation ► Cross Section 
► Annotate Cross Section ► Features.

 The XIN has been revised in order to import GDOT Trimble CSV files.  The command File 
► Import ► Survey Data now has a pull down selection named GDOT Trimble (.csv).

  Edited the style TOPO_E_TIRRLMT so it could be used in the Geometry module.  This is 
a Feature Style that represents Irrigation Limits and is most often picked up as a feature 
that goes to the DTM but is sometimes collected as a horizontal alignment which goes 
to the Geometry module.

 Edited all styles with the BRDG_, DRNG_, LIMT_, and MAIN_ prefixes to ensure all check 
boxes under 3-D/Plan Display, Cross Section Display and Profile Display were checked.  
This is found under Tools ► Style Manager ► “Style” ► Surface Feature.

 The Plan and Profile Generator Preferences were revised to generate multi-sheet 
Profiles for 20 & 50 Scale Double & Single Profile Preferences instead of Single Sheet.

10-15-11: Updated INROADSALLV8i.EXE

Updated:  Standard Files:
 XIN File – Various updates/revisions. (See update/revision list in the Table 

depicted below).
 QA Checklists for Photogrammetry and Survey Processing – QA PDF 

documents were updated to correct erroneous wording for DTM ‘Spike’ checks.
GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT 3D Alignment Comparison Report.pdf
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 Added Style Sheet Help File – GDOT Intersecting Alignment Stations.pdf
GDOT Style Sheets
 Added Style Sheet – GDOT 3D Alignment Comparison Report.xsl
 Added Style Sheet – GDOT Intersecting Alignment Stations.xsl

 The preferences listed below were edited to set up the annotation of a Station Equation 
on an alignment.  The preferences are located under the command Geometry ► View 
Geometry ► Stationing. 

 CONSTCL                              DETCL                               SIDECL
 CONSTCL 20 SCALE            DETCL 20 SCALE              SIDECL 20 SCALE
 Two new preferences named SE LEFT and SE RIGHT were created for the command 

Drafting ► Display Superelevation in Plan.  These preferences are for displaying the 
Transition Stations and Superelevation Rate for a developed Corridor and 
Superelevation Control Line.  SE LEFT displays information to the left of the Pivot Line 
defined in the command and SE RIGHT displays information to the right of the Pivot Line 
defined in the command.  At this time the command does not label the transition 
description (i.e. End NC, Begin NC, Flat, RC, Begin FS, etc.).  All information is displayed 
on the level MAIN_P_Details-Super-Elev-Trans-Label-Text.

 The preferences listed below were edited to correct the orientation of the alignment 
Station text to match that shown in the Plan Presentation Guide.  The preferences are 
located under the command Geometry ► View Geometry ► Stationing.  The 
preferences were also enhanced to setup viewing of Event Point Stations and Offsets 
and Vertical Alignment Cardinal Point Stations information in the plan view if the 
Designer chooses to check these buttons on. The information for the Event Points and 
Vertical Alignments displays on the level MAIN_P_Misc-Details-Info and 
PROF_P_Finish-Text.

 CONSTCL                              DETCL                               SIDECL
 CONSTCL 20 SCALE            DETCL 20 SCALE              SIDECL 20 SCALE
 The preference ‘GDOT Profiles’ under the command Geometry ► View Geometry ► 

Vertical Annotation was edited to place the text VLOW and VHIGH rather than LO and 
HI.  This was done so that the text on the Profile Sheets would match the text generated 
in Reports.

 The feature type of the feature style TOPO_E_DEW was changed from Interior to 
Breakline.  The reason for this change is because survey collects this feature as a non 
closed shape.  With the feature type set to Interior, InRoads creates a closed shape of 
the item when it is imported into the DTM and this is not desired.  The surveyed item is 
a 2D non-triangulated item and will remain a 2D non-triangulated item.

07-01-11: Updated INROADSALLV8i.EXE

Updated:  Standard Files:
 XIN File – Various revisions to several Feature Styles, Named Symbologies and 

Filters. See complete Revision  List depicted below:  

 The Feature Styles listed below were edited to ensure the checkbox for ‘Geometry Spiral 
Feature’ was checked.  This is located under Tools – Style Manager and clicking the Edit 
button for the Style to edit.  While spirals are not typically used in current design of 
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Highways, the processing of existing plans and deeds during the surveying process of 
current projects has come across R/W and centerline alignments that were designed 
using spirals.  The ‘Geometry Spiral Feature’ checkbox needs to be checked in order to 
properly display the correct line style.  The Feature Styles listed here did not already 
have this check box selected.

 MAIN_P_SIDECL                                         PROP_E_PAR
 PROP_E_BCOL                                            PROP_E_RWRR
 PROP_E_BCTL                                             PROP_E_RWU
 PROP_E_BLDL                                             REQD_E_DWESMT

 All of the line style Named Symbologies (except for LIMIT_P_Const-Limit-Fill and 
LIMIT_P_Const-Limit-Fill) were changed from a Scale of 0.02 to 1.00 and the Scale check 
box was checked so the Global Scale Factor of 20, 50, etc. would be applied.  The 
custom line styles LIMT-Fill and LIMT-Cut appear to have been drawn at a different 
scale factor than the other custom line styles.

 The following Feature Style (MAIN_P_EEOP)  was edited to make it available for 
selection on alignments in the ALG. 

 Created a Preference named PAR NAMES for the command Geometry ►View 
Geometry ► Closed Areas.  This is to view the alignment names for closed alignments 
in MicroStation. 

 Edited the Filter DTM Surface Codes to now exclude code 244 (SCCHK).  This filter was 
used with the Survey > Survey Data to Surface command.  This code was removed at 
the request of survey.  It is used only during field work and is supposed to be removed 
from the ASC file before importing into CAiCE (i.e. InRoads) according to the CAiCE 
survey processing guidelines page 21.  At times the code is not removed from the ASC 
file and has to be manually removed from the CAiCE database (i.e. the InRoads DTM and 
ALG).  Editing the Filters prevents this code from ever entering the DTM or ALG and 
saves the SDE editing time.

 Edited the Filter Property and Alignment Codes to remove code 244 (SCCHK).  This Filter 
was used with the Survey ► Survey Data to Geometry command.  The change was 
made for the same reason as listed above.

 The following Feature Styles were edited to make them available for selection on 
alignments in the ALG.

                        
o MAIN_P_ Barrier-Median-Side MAIN_P_ EPSHLDR
o MAIN_P_ Barrier-Noise-Wall MAIN_P_ Guardrail
o MAIN_P_ Barrier-Retain-Wall MAIN_P_ Misc-Const-Feat
o MAIN_P_ CROWN                                       MAIN_P_ Sidewalk
o MAIN_P_ Curb                                             MAIN_P_ Slope-break
o  MAIN_P_ Driveway

 The following Feature Styles and Named Symbologies were created for use in the 
Roadway Designer Vertical Gore Design Tool.

                        Feature Style Named Symbology

o MAIN_P_GoreMax - MAIN_P_GoreMax
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o MAIN_P_GoreMainIdeal - MAIN_P_GoreMainIdeal
o MAIN_P_GoreRampIdeal - MAIN_P_GoreRampIdeal
o MAIN_P_GoreMin - MAIN_P_GoreMin

 The Preference named Vertical Gore Design Tool was created for use in the Roadway 
Designer Vertical Gore Design Tool.  This Preference loads the Feature Styles listed 
above into the proper fields.

 The 50 Scale and 20 Scale Preferences located under Tools ► Survey Options ► 
Symbology Tab ► Edit View button, were corrected to set up the View Text Symbology 
dialog to enter settings of Text Height - .15, Text Width - .15 and Line Spacing - .10 for 
the 50 Scale Preference and Text Height - .375, Text Width - .375 and Line Spacing - .25 
for the 20 Scale Preference.

04-01-11: Updated INROADSALLV8i.EXE

Updated:  Standard Files:
 XIN File – Various revisions to several Feature Styles. Added Bridge Hydraulics 

Feature Style and Preference, Edited Survey Style Filter to include Feature 
Codes 240-245 to the Property and Alignment Codes filter, revised the 50 Scale 
and 20 Scale Preferences text width and line spacing.

 ITL File – Edited the template documentation link for each component so the 
path would already be listed when the Template Documentation Link button 
was clicked for each component.

GDOT Style Sheet Documentation
 Added Style Sheet Help File – GDOT Feature-StationElevationOffset Report.xsl
 Added Style Sheet Help File – GDOT GPS Grading Report. xsl
 Added Style Sheet  Help File– GDOT HEC RAS Bridge Features Report.xsl
 Added Style Sheet  Help– GDOT HEC RAS Cross Section Geometry Report.xsl

GDOT Style Sheets
 Added Style Sheet – GDOT Feature-StationElevationOffset Report.xsl
 Added Style Sheet – GDOT GPS Grading Report. xsl
 Added Style Sheet – GDOT HEC RAS Bridge Features Report.xsl
 Added Style Sheet – GDOT HEC RAS Cross Section Geometry Report.xsl

09-15-10: Updated INROADSALLV8i.EXE

Updated:  Standard Files:
 XIN File – Various revisions to all Feature Styles, removed ‘Attach Tags’ to all of 

the Feature Styles, revised custom attributes on ‘Dimension Feature Styles”,  
changed linear precision to 3 decimal places.

 QA Documents.docx – QA Word documents for Photogrammetry, Survey and 
Design were replaced with PDF documents.
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07-15-10: Updated INROADSALLV8i.EXE

Updated:  GDOT Style Sheets:
 Style sheet GDOT Alignment Points List.xsl – Corrected title
 Style sheet GDOT Feature Volumes Report.xsl – Corrected title.

Updated:  Standard Files:
 Design Data_InRoads QA.docx – Corrected several ‘pull downs’ in the verified 

column.
 Survey Data Processing_InRoads QA.docx – Added a line for ensuring the 

Surface Properties Symbology Preferences were set to “EXISTING” for both the 
Cross Sections and Profiles.

 07-01-10: Released INROADSALLV8i.EXE – Initial Version
Standard Files Released:
 GDOT_Standard V8i.xin
 GDOT_Standard V8i.itl
 Project_Data_Sheet_MultipleAlign.docm
 Photogrammetry_InRoads QA.docx
 Survey Data Processing_InRoads QA.docx
 Design Data_InRoads QA.docx

Component Description Documentation
GDOT Style Sheet Documentation
GDOT Style Sheets
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